New Perspectives on Microsoft Excel 2016

Module 1:
Getting Started with Excel
Objectives, Part 1

- Open and close a workbook
- Navigate through a workbook and worksheet
- Select cells and ranges
- Plan and create a workbook
- Insert, rename, and move worksheets
- Enter text, dates, and numbers
- Undo and redo actions
- Resize columns and rows
Objectives, Part 2

• Enter formulas and the SUM and COUNT functions
• Copy and paste formulas
• Move or copy cells and ranges
• Insert and delete rows, columns, and ranges
• Create patterned text with Flash Fill
• Add cell borders and change font size
• Change worksheet views
• Prepare a workbook for printing
• Save a workbook with a new filename
Visual Overview, Part 1

The ribbon is organized into tabs. Each tab has commands related to particular activities or tasks.

The ribbon contains buttons that you click to execute commands to work with Excel.

The Name box displays the cell reference of the active cell. In this case, the active cell is cell H1.

The row headings are numbers along the left side of the workbook. They are used in different views of the worksheet.

The status bar provides information about the worksheet.

The sheet currently displayed in the workbook window is the active sheet. Its sheet tab is underlined, and the sheet name is green and bold.

Inactive sheets are not visible in the workbook window; their sheet tabs are not underlined and their sheet name is black.

Excel stores spreadsheets in files called workbooks. The name of the current workbook appears in the title bar.

The formula bar displays the value or formula entered in the active cell.

The formula bar displays the value or formula entered in the active cell.

A group of cells in a rectangular block is called a cell range or range. If the blocks are not connected, as shown here, it is a nonadjacent range.

The column headings are letters along the top of the workbook. They are used to identify columns of the worksheet.

Each intersection of a row and column is a cell. Each cell contains a value or formula. The currently selected cell is the active cell.

A workbook is made up of sheets. Each sheet is identified by a sheet name, which appears in a sheet tab.

The Zoom controls increase or decrease the magnification of the worksheet content. These tutorials show worksheets zoomed to 100%.
Introducing Excel and Spreadsheets, Part 1

• Computer program used to enter, store, analyze, and present quantitative data in an organized and easily updatable manner

• Creates electronic versions of spreadsheets
  • Collection of text and numbers laid out in a grid

• Displays values calculated from data

• Represents data in both text and graphical from through the use of charts
Introducing Excel and Spreadsheets, Part 2

• Allows what-if analysis
  • Ability to change values in a spreadsheet and assess the effect they have on calculated values automatically

• Automates many tasks through the use of formulas including both automatic formulas and custom formulas

• A Quick Analysis tool allowing conversion from data to charts in two easy steps
Introducing Excel and Spreadsheets, Part 3

- Integrates data from several spreadsheets within a single workbook, and also interfaces with other workbooks when data from multiple sources is required.
- Templates already available for budgets, calendars, forms, and reports.
- A new Flash Fill feature allows you to have data automatically entered based on initial data you enter.
• Excel 2016 offers a Chart Recommendation feature suggesting the best chart to fit your data needs

• Excel also increased filtering functionality adding an interactive way to easily filter data in query tables and Excel data tables

• Excel 2016 adds a One Workbook, One Table feature allowing you to view multiple workbooks simultaneously
Excel 2016 includes additional functions in several areas including basic math, trigonometry, statistics, look-up, and text functions.
Exploring a Workbook, Part 1

• A workbook can have two kinds of sheets:
  • Worksheet contains a grid of rows and columns into which user enters data
  • Chart sheet provides visual representation of data

• Cell reference identifies column/row location

• To navigate between worksheets
  • Use sheet tabs

• To navigate within a worksheet
  • Use mouse, keyboard, GoTo dialog box, or type cell reference in Name box
• Use a planning analysis sheet to define:
  • Goal or purpose of workbook
  • Type of data to collect
  • Formulas needed to apply to data you collected and entered
  • Appearance of workbook content
• Inserting a worksheet
  • Name of new worksheet is based on number and names of other sheets in the workbook

• Deleting a worksheet

• Renaming a worksheet
  • 31 characters maximum, including blank spaces
  • Width of sheet tab adjusts to length of name
- Moving and copying a worksheet
  - To move:
    - Click and drag
  - To copy:
    - Ctrl + drag and drop
  - Place most important worksheets at beginning of workbook (leftmost sheet tabs), less important worksheets toward end (rightmost tabs)
Starting a New Workbook

• You create new workbooks from the New screen in Backstage view from the Blank workbook template.
  • On the ribbon, click the File tab to display Backstage view.
  • Click New in the navigation bar to display the New screen.
  • Click the Blank workbook tile.
• Text data
  • Combination of letters, numbers, and symbols
  • Often referred to as a text string

• Number data
  • Numerical value to be used in a mathematical calculation

• Date and time data
  • Commonly recognized formats for date and time values
• New data appears in both the active cell and the formula bar

• Truncation

• AutoComplete feature

• To enter multiple lines of text within a cell
  • Create a line break with Alt + Enter
Entering Text, Dates, and Numbers, Part 3

Your name appears here

Text covers the empty cells to the right

Game Card
Author: Peter Lewis
Date: 
Purpose: To record customer game orders
Entering Text, Dates, and Numbers, Part 4

- Green triangle flags a potential error in the cell.
- Postal code is left-aligned in the cell.
- An apostrophe before the number tells Excel to treat the number as text.
• As you work, you might find entries you need to change or correct.
  • If you want to replace all of the content in a cell, you simply select the cell and then type the new entry to overwrite the previous entry.
  • If you need to replace only part of a cell’s content, you can work in Edit mode.
Editing Cell Content in Edit Mode

- **Edit Mode**
  - Double-click the cell to select the cell and switch to Edit mode
    - A blinking insertion point appears within the text of cell
  - Press the arrow keys to move the insertion point to the right of the word being edited
  - Press the Backspace key three times to delete the word being edited
  - Type & to enter the new text, and then press the Enter key
Entering Text, Dates, and Numbers

- Use Edit mode to edit cell contents
  - Keyboard shortcuts apply only to text within selected cell
- Undoing and redoing an action
  - Excel maintains a list of actions performed in a workbook during current session
Resizing Columns and Rows, Part 1

• To make data easier to read:
  • Modify size of columns and rows in a worksheet

• To modify size of columns or rows:
  • Drag border to resize
  • Double-click border to autofit
  • Format the Cells group to specify
Resizing Columns and Rows, Part 2

• Column width
  • Expressed in terms of number of characters or pixels (8.43 characters equals 64 pixels)
  • Note: Pixel size is based on screen resolution

• Row height
  • Measured in points (1/72 of an inch) or pixels
  • Default row height: 15 points or 20 pixels
Resizing Columns and Rows, Part 3

- Deleting and clearing a row or column
  - Deleting removes both the data and the cells
  - Clearing removes the data, leaving blank cells where data had been
Wrapping Text Within a Cell

- Wrapping text enables text to display on two or more rows within one cell allowing more text within a narrower column.
  - Resize the width of column as appropriate.
  - Select the cells you wish to apply wrapping to.
  - On the Home tab, in the Alignment group, click the Wrap Text button.
    - The Wrap Text button is toggled on, and text in the selected cells that exceeds the column width wraps to a new line.
Selecting a Cell Range, Part 1

• Range reference indicates location and size of a cell range
  • Adjacent (A1:G5)
  • Nonadjacent (A1:A5;F1:G5)

• Selecting a range
  • Work with all cells in the range as a group

• Moving and copying a range
  • Drag and drop
  • Cut and paste
Selecting a Cell Range, Part 2

- Inserting and deleting a range
  - Existing cells shift to accommodate the change

- Select the cell or range you want to move or copy

- Move the pointer over the border of the selection until the pointer changes shape

- To move the range, click the border and drag the selection to a new location
  - Or to copy the range, hold down the Ctrl key and drag the selection to a new location
Selecting a Cell Range, Part 3

• Select the cell or range you want to move or copy
• On the Home tab, click the Cut or Copy button
  • Or right-click the selection, and then click Cut or Copy on the shortcut menu
• Select the cell or the upper-left cell of the range where you want to paste the content
• Click the Paste button
Visual Overview, Part 2

In Excel, every formula begins with an equal sign (=).

When the active cell contains a formula, the formula appears in the formula bar, and the result of the formula appears in the cell.

The gridlines that surround cells appear on the worksheet as a guide; they do not print.

A border is a line that you add along an edge of a cell. Borders are used to improve the readability of the worksheet.

The Sum function adds the values in the specified range.

The Page Layout tab is used to specify how the worksheet will be arranged and printed.

AutoSum quickly inserts functions to sum, average, or count values in a range or find the minimum or maximum value in a range.

A formula is an expression that calculates a value. These formulas multiply values in different cells.

A function is a named operation that replaces the action of an arithmetic expression.

Page Break Preview shows the location of page breaks in the printed worksheet.

Normal view shows the contents of the active sheet in the workbook window.

Page Layout view shows how the worksheet will appear when printed.
Performing Calculations with Formulas, Part 1

• Formula
  • An expression that returns a value
  • Written using operators that combine different values, resulting in a single displayed value
Performing Calculations with Formulas, Part 2

- Entering a formula
  - Click cell where you want formula results to appear
  - Type = and an expression that calculates a value using cell references and arithmetic operators
    - Cell references allow you to change values used in the calculation without having to modify the formula itself
  - Press Enter or Tab to complete the formula

- Order of precedence
  - Set of predefined rules used to determine sequence in which operators are applied in a calculation
Performing Calculations with Formulas, Part 3

• Viewing a formula
  • Select cell and review expression displayed in the formula bar
  • Each cell reference is color coded in the formula and corresponding cell in the worksheet
Performing Calculations with Formulas, Part 4

- Copying and pasting formulas
  - Cell references adjust to reflect new location of the formula in the worksheet

- Guidelines for writing effective formulas:
  - Keep them simple
  - Do not hide data values within formulas
  - Break up formulas to show intermediate results
Simplifying Formulas with Functions

• Function
  • Named operation that returns a value
  • Simplifies a formula, reducing a long formula into a compact statement; for example, to add values in the range A1:A10:
    - Enter the long formula:
      \[=A1+A2+A3+A4+A5+A6+A7+A8+A9+A10\]
    - Use the SUM function to accomplish the same thing:
      \[=\text{SUM}(A1:A10)\]
• Fast, convenient way to enter commonly used functions

• Includes buttons to quickly insert/generate:
  • Sum of values in column or row (SUM)
  • Average value in column or row (AVERAGE)
  • Total count of numeric values in column or row (COUNT)
  • Minimum value in column or row (MIN)
  • Maximum value in column or row (MAX)
Entering Functions with AutoSum, Part 2

<table>
<thead>
<tr>
<th>VLOOKUP</th>
<th>formula appears in the formula bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Stock ID</td>
</tr>
<tr>
<td>13</td>
<td>SG71</td>
</tr>
<tr>
<td>14</td>
<td>FG14</td>
</tr>
<tr>
<td>15</td>
<td>PG05</td>
</tr>
<tr>
<td>16</td>
<td>SU38</td>
</tr>
<tr>
<td>17</td>
<td>SG29</td>
</tr>
</tbody>
</table>

SUM function adds the values in the selected range

AutoSum button arrow

ScreenTip shows the syntax of the SUM function

Cells used in the function are highlighted

Range reference
Modifying a Worksheet

- Moving and Copying a Cell or Range
- Using the COUNT Function
- Inserting a Column or Row
- Deleting a Row or Column
- Inserting and Deleting a Range
Using Flash Fill

- Flash Fill enters text based on patterns it finds in the data
- Flash Fill works best when the pattern is clearly recognized from the values in the data
Formatting a Worksheet

• Adding Cell Borders
• Changing the Font Size
Printing a Workbook, Part 1

- Changing worksheet views
  - Normal view
  - Page Layout view
  - Page Break Preview
Page Layout View

Worksheet will span two printed pages

Page Layout button
Changing the Page Orientation

• Working with page orientation
  • Portrait orientation (default)
    - Page is taller than wide
  • Landscape orientation
    - Page is wider than tall
Setting the Print Options

• Print tab provides options for choosing what to print and how to print
  • Printout includes only the data in the worksheet
  • Other elements (e.g., row/column headings, gridlines) will not print by default

• Good practice: Review print preview before printing to ensure that printout looks exactly as you intended and avoid unnecessary reprinting
Printing a Workbook, Part 2

printout scaled to fit all of the rows and columns on one page
Viewing Worksheet Formulas

• Switch to formula view
  • Useful when you encounter unexpected results and want to examine underlying formulas or to discuss your formulas with a colleague

• Scaling the printout of a worksheet forces contents to fit on a single page
Saving a Workbook with a New Filename

• Whenever you click the Save button on the Quick Access Toolbar or press the Ctrl+S keys, the workbook file is updated to reflect the latest content.

• If you want to save a copy of the workbook with a new filename or to a different location, you need to use the Save As command.

• When you save a workbook with a new filename or to a different location, the previous version of the workbook remains stored as well.